
2.5.0 (from 2.3.0) 
p:IGI+ version 2.5 was the version shown at the 2024 user group. In version 2.5 we have added 

significant functionality designed to support a range of workflows and increase user efficiency. 

New/Improved features (p:IGI+ and Metis Transform) 
• We have introduced the concept of a ‘dashboard’, allowing the user to create complex 

arrangements of graphs, maps and bar charts / box and whisker plots. 

o users can add selected (graph, map and statistics) artefacts to dashboards 

▪ artefacts on dashboards are fully interactive to brushing, pan zoom etc 

▪ palettes and sample sets can be applied to individual artefacts when they 

are on a dashboard  

▪ artefacts are locked in the artefact tree once applied to a dashboard (but 

can easily be removed from the dashboard 

o palettes and graphs can be applied to all entities on a dashboard by being dropped 

onto the ‘Drop zone’ on the dashboard toolbar 

▪ using the “Apply to all open artefacts” right click option on palettes and 

sample sets will apply to all open dashboards and all artefacts on them 

o dashboards can be configured to have a maximum of 4 by 4 panels, and can be laid 

out using the dashboard editor 

▪ at creation the user can select the default configuration 

▪ the dashboard editor allows the user to define the partition of the 

dashboard space to cater for non-regular dashboards 

o dashboards can have artefact information added and saved as templates 

▪ auto-dashboards are supported and will list the artefacts applied to them in 

the preview 

▪ users will be able to add their own, and company auto-artefacts 

o dashboards can be docked in the p:IGI+ workspace providing an option of using that 

effectively 

o dashboards can be copied as a whole from the dashboard toolbar 

o the default dashboard size can be set in the Dashboards settings section from the 

main settings menu 

o underlays and overlays can be edited in place is dashboards, although we do not 

recommend doing this due to the limited space available 

• A first version of the collocation tool has been built 

o the default grouping is based on the sample (row) being from the same well, at the 

same depth, or at the same location (lat,long or x,y) 

▪ the user can select to include sampling time as a grouping option, but this is 

excluded by default as often samples will not record sampling time 

▪ the user can set a tolerance on the matching for all numeric properties 

▪ strings must match exactly (case insensitive) 

o users can select the mechanism by which samples are grouped together choosing up 

to three user criteria 

▪ depth can be included as a fourth criteria if desired 

▪ samples without the user criteria will attempt to group using the location, 

depth and optionally time criteria 



o users can preview the groups before deciding on whether to create the collocated 

samples 

o for samples that collocate and have conflicting values the collocated sample created 

from the group is assigned the mean value, and the standard deviation is written to 

the corresponding uncertainty value 

▪ for long strings all the values are concatenated (chained together) 

▪ for short strings all the values are concatenated (chained together) and if 

necessary the string is truncated 

o if the user selects to create the collocated samples, these are automatically added to 

the project as new samples (which p:IGI+ knows are collocated) 

▪ static sample sets are created for the collocated samples + the unique 

samples, just for the collocated samples, just for the unique samples and 

also for those samples which were grouped and contributed to the 

collocated samples 

• these sample sets can be used as any other, including in the project 

sample filter 

o the collocations are remembered in the project on save and will be present if 

another user opens the project 

▪ the user can open the collocation manager at any point to review the 

collocation criteria used, and explore the samples that were grouped 

o the collocation can be cleared at any time, returning the project to its original state, 

removing the collocated samples and the associated sample sets  

o a visual indicator is provided in the toolbar showing that a collocation is active 

▪ if a sample contributing to a collocation is edited the user is informed that 

the collocation is out of date 

• Bar charts have been added to allow the graphical display of contingency tables, showing the 

relationship between the number of samples in two properties (multi-variate frequency 

distribution) 

o the original contingency table has now been removed 

o colour and shape palettes are used to define the two groupings, so both discrete 

and binned continuous properties can be used 

▪ interaction with palette show/hide entries provides flexible control over 

classes / bins shown 

o sample sets can be applied to filter the data 

o a data summary can be added either above, to the right or below to enable flexible 

use in dashboards 

o the y-axis maximum can be configured if desired to provide comparisons 

▪ user can show counts or percentages on the y-axis 

▪ horizontal grid lines can be shown / hidden 

o a tabular view can be selected in the artefact, or on a dashboard 

▪ table styling can be controlled and remembered 

o the chart can be copied as an image, with or without the legends 

▪ the legends can be copied individually 

▪ if the tabular view is copied, a text table is put on the clipboard 



• Box and whisker charts have been added to allow the graphical display of pivot tables, 

showing the relationship between a continuous property and the samples in up to two 

discrete properties 

o the original pivot table has now been removed 

o colour and shape palettes are used to define the two groupings, so both discrete 

and binned continuous properties can be used 

▪ interaction with palette show/hide entries provides flexible control over 

classes / bins shown 

o sample sets can be applied to filter the data 

o it is possible to show just the box and whisker element, just the points or both 

▪ a distribution curve can also be shown 

o the box and whisker element is based on robust statistics (median centre line, top 

and base of box at 75th and 25th percentile, whiskers to 1.5 times the interquartile 

range, above and below) 

▪ optional you can show the mean centre line, the box to show the standard 

error of the mean, and the whiskers to show plus / minus the standard 

deviation of the data  

o a data summary can be added either above, to the right or below to enable flexible 

use in dashboards 

o the y-axis minimum and maximum can be configured if desired to enable 

comparisons 

▪ user can select to show in log or linear axes 

▪ horizontal grid lines can be shown / hidden 

o a tabular view can be selected in the artefact, or on a dashboard 

▪ table styling can be controlled and remembered, including the display 

precision 

▪ users can show the mean, or the mean +/- the standard deviation in the 

tabular view 

o the chart can be copied as an image, with or without the legends 

▪ the legends can be copied individually 

▪ if the tabular view is copied, a text table is put on the clipboard 

• The statistics artefact has been updated to allow it to be applied to dashboards 

o the presentation of the statistics view has been cleaned up 

o the user can select to transpose (swap row-columns) statistics to show summary 

information efficiently on dashboards 

o controls have been moved the right click options to clean up the presentation of key 

information 

o the filter summary is used to show if any sample sets are applied 

• We have added a list of up to 20 recently used projects in the Project → Open recent → 

menu 

• Working on files stored on remote drives should be more stable and performant 

o users can configure the location for their working files and backup files when using 

p:IGI+ 

▪ ideally the working folder and backup folder should be on a local drive with 

fast access times 



o p:IGI+ will no longer create large lock files, rather a small lock file will be write to the 

location of the project file being opened 

▪ the user will be given the option to ignore the lock file and open the project 

anyway, meaning no more copy of copy of copy … 

▪ backup files will be created to allow for easier recovery, with the backup 

location being specified by the user 

• Menu’s have been reorganised to better reflect workflows, splitting the statistics and model 

menus 

• Settings have all been moved to a common Settings menu to allow you to easily find all 

application / user settings 

o the location of the default project is now a setting, so this could be placed centrally 

and shared across a company 

o the Metis connections are managed in the settings, and have been updated to 

provide clearer guidance on connection issues 

o the table colour and chart sizes for contingency and box and whisker charts can be 

defined 

• Shape palettes autofill order provides more distinct shapes, moving the triangles to the last 

position in the solid shapes 

• Sorting in palettes uses a natural sort order that works for well names and text properties 

• A project sample filter has been added – this restricts all interactions in p:IGI+ to the 

selected static or dynamic sample set, so you effectively work only on a subset of your 

project data 

o both dynamic and static sample sets can be assigned as the project sample filter 

using a right click from the artefact 

o the filtering applies to all operations in the project (what is shown on graphs, maps, 

palettes, pages, statistics, merge, harmonise, collocate, PCA, clustering, properties 

with data, find a data set and export). The only aspect not affected is saving the 

project, where all data is always saved, alongside any project sample filter 

▪ also applies to project merge in Transform, and upload to staging 

o the project sample filter can be combined with other sample sets and always uses 

the AND (intersection) operation 

▪ this allows you to combine static and dynamic sample sets 

o you can remove the project sample filter at any time 

o all artefacts show a visual indication that a project sample filter is applied 

▪ the filter summary will show the project sample filter name if applied 

o application can be done or undone at any time 

o counts shown on the information summary on graphs, maps and statistics respect 

the project sample filter 

• When creating sample sets the user now has the option to use criteria from other existing 

sample sets, making it very easy to combine sample sets 

o when creating multiple sample sets the user can now add additional criteria to all of 

the multiple sample sets created 

o when adding samples to a static sample set, you can also select to add the 

unselected samples to a sample set, creating the set complement of the selected 

samples 



• Rule sets are created in their create dialogue 

• Artefact tree folders can have their contents sorted. This uses a natural sort order, that 

works for wells, etc, as well as normal text. The sort is case insensitive 

o user folders (yellow in colour) can be added to any existing (blue) base folders, and 

moved anywhere in the tree 

o folder information can be added to user folders and filtering will respect this 

• An artefact collection concept has been added to the system allowing user to export 

(nested) folders as templates, enabling groups of artefacts to be exported together as a 

single collection, often supporting a specific workflow 

o if a sample set or palette is exported applied to several artefacts only a single 

instance is imported the referenced from the other artefacts helping reduce the 

number of instance created 

o users can provide tags, a description and a help link for artefact collections 

o we have added support for auto-artefact collections and provided several examples 

to illustrate their power in supporting standardised workflows 

o any artefact type, including dashboards, can be contained in artefact collections 

o users can create and add their own artefact collections, using the same folder as the 

user auto-artefacts 

• Maps: where possible we will convert the coordinate system of shapefiles to the correct 

WGS84 Lat/Long projection when reading. It is no longer necessary to use a GIS system to 

convert shapefiles to WGS84 Lat/Long for use in p:IGI+ 

o shapefiles will read UTF-8 encoded field values 

o shapefiles will support geometries which include a ‘Z coordinate’ 

o the toolbar can be hidden on the map, as can the lat/long position which can be 

especially useful on dashboards 

▪ zoom to data, label points, and open layer manager have been added as a 

right click option 

o the data, filter and project summary can be shown on the maps and the position can 

be set to top, right and bottom 

o maps are now constrained to -180 to +180 degrees longitude 

▪ this means you can only ever see one ‘world’ at a time, and ensures the data 

summary will always give the correct count of the number of samples 

o the map size can be set like graphs to allow users to copy identically sized maps 

o users can zoom on a map using the rectangle zoom tool 

• Graphs have been improved to allow user to set the size more effectively 

o the information summary on graphs has been split into a data summary, a filter 

summary and a project summary 

▪ these can be placed above, below or to the right of the graph area allowing 

for better use of space, especially on dashboards 

• this is controlled per graph from the Layout tab in graph manager. 

Selecting the information summary layer gives the placement 

options 

o user can select to show the coordinates of the points on scatter plots, depth plots 

and multi-depth plots 

▪ available from the Layout tab on graph manager in the Coordinates layer 



• can set the display precision by selecting the Coordinates layer 

o histograms now show out of range data correctly 

▪ the bars are clipped at the top of the graph space 

o user defined graphs are created with the title off by default 

• The project analysis overview has been improved to show all property groups with slightly 

more detail in the breakdown 

 

Machine learning features 
• A new learning set finding tool has been developed in p:IGI+ 

o you can select to find a good learning set across all properties and samples in your 

project, of you can restrict your selection based on a page or sample set 

▪ optionally select the minimum number of values in a property to be 

considered for inclusion 

o select the groups of properties to be considered for inclusion based on the advanced 

property filtering 

o once the data from the selected properties has been identified, you can then select 

which property groups, and indicators to use 

o optionally select a target property which you want to try and predict 

▪ select to only include samples which have the target property 

▪ optionally choose only properties with at least a certain number of values 

for the target property 

▪ select whether to use mutual information (and the associated threshold) to 

select inputs that are informative about the target property. Mutual 

information is a generalisation of correlation, and describes the amount of 

information (entropy) that one property gives about the other property 

o you can then select whether you want to have more samples (rows), or more 

properties (columns) 

▪ additionally, you can specify the minimal % of properties that must be 

occupied per sample, and samples that must be occupied per property 

o interaction allows you to explore many options to get a suitable data set for 

machine learning (or more generally for data exploration)  

▪ once happy with the options you can name the page and static sample set to 

create to show the data 

▪ this page can then be used for training machine learning models 

• The machine learning tools can now be used alongside p:IGI+, allowing you to interact with 

maps, graphs, pages etc in p:IGI+ while also using the ML tools, saving a lot of back and forth 

when building models 

o the user is notified if any data used in the ML models has been changed in pIGI+ 

preventing saving models using the wrong data 

• Machine learning models can now use the same property in multiple indicators as inputs 

o the property names now include the indicators and units for better contextual 

information in the ML tool 

• Machine learning models can be saved as templates and moved to other projects 



o right clicking on the model in the ML model manager provides the export model 

option 

o an import model button is provided at the top of the list of models in the model 

manager 

• Preprocessing includes an outlier detection feature 

o the feature allows control over the sensitivity of the detection methods 

o exploratory tools allow exploration of the reasons for samples being outliers 

• Regression model support log and square root transformations of the input properties 

o we have added Gaussian process regression, which sends back error bars with the 

predictions 

• The ML tools support classification 

o visualisation of class assignments, and misclassifications supports the inspection of 

the models 

o performance of classification models is supported through confusion matrix and 

ROC analysis 

• Clustering visualisation has been improved 

o colouring of clusters is more consistent between different models and cluster 

numbers 

o the colouring of the dendrogram reflects the cluster colours allowing a clearer 

overview of the splits in the data 

o the naming of the clusters from a hierarchical cluster model shows the path to the 

clusters allowing reconstruction at lower levels of detail 

o visualisation supports 2D and 3D reconstruction in the reduced dimension space 

given by the dimension reduction approach, or spatially (lat, long, depth) or in data 

space 

o users can select samples in the views and remove these from further analysis 

Metis specific features 
• Support for uploading PVT files (.pdf, .xlsx, .xml, .json) and attaching them to samples or 

other PVT files has been added  

o PVT files can be the source of data for samples or derived from other PVT files 

allowing PVT models to be associated with source reports 

o the long term aim is to integrate Metis with Calsep’s PVTSim  Nova software so that 

PVT data can be seamlessly shared across departments 

o PVT files can be individually deleted 

• Support for uploading chromatogram files (.pdf, .xlsx, .jpg, .png) and attaching them to 

samples has been added: 

o chromatogram files can be attached to multiple samples and the relevant analyses 

specific 

o these chromatogram files can then be viewed and retrieved directly from within 

p:IGI+ 

o individual chromatogram files can be deleted 

• Sign in: We have improved the sign-in experience with Metis 

o users can now opt to be kept signed in, which should reduce the frequency a user is 

asked for their login credentials 



o Metis Discover now shares sign in information with p:IGI+ and Transform meaning a 

user should only have to sign in once rather than twice to download data 

• The layers that are shown on the map within Metis Discover are more robust to errors 

• We improved the usability of Transform Online: 

o the quick search panel and queries are shared across the Discover, harmonise and 

file views 

o user queries captured in the activity log can be re-queried directly from within 

Transform Online 

o the notifications for blocking operations within Metis Transform Online are now less 

intrusive 

• We’ve made several improvements to Metis Transform: 

o PVT samples with very limited metadata can be uploaded and retrieved in Metis 

Transform using the Lab#.PVT property 

o project merge within Metis transform can now be undertaken within a sample set if 

desired 

o fixed a minor issue with matching well samples with non-well samples in Metis 

Transform 

• Wells (candidate wells) can now be manually created in Transform 

• Bulk delete: we have introduced a tool that can remove large datasets from Metis 

 

Property model  
• To facilitate the storage of data from more complex wells, in particular, from sidetracks/laterals 

spurred from an original well bore, the Well group has been supplemented with a Parent 

Name and Parent# (ID) property to record the borehole from which the sampled borehole 

originated came. 

o   Additional location properties are provided to record the location of the well TD and 

locate the wellhead using an alternative geoid. 

• The Sample group sees the relocation of the gas type information from the individual gas 

groups to the Gas type.Sample property. 

o Water depth has also been added to the sample group if needed.  

• A Digital Object Identifier (DOI) for the source document has been added to the Ref Group 

• The Geol chronostratigraphy schema has been expanded to include a new Eon level property to 

assist in recording Precambrian stratigraphy assignments. Alongside this:  

o Updated descriptions are provided for the Alternative chronostrat & lithostrat 

properties to reflect the ability that users can populate these properties from an 

alternative set of strat tops loaded into the well manager. 

o Reported top & base reservoir properties now allow internal reservoir units to be 

stored in projects. An associated source property for this information is also 

provided. 

• The reservoir associated production index property (RA-PI) has been added to the Pyrol-6 

group (S1+S2a)/(S1+S2a+S2b). This is otherwise known as the Total production index (TPIr). 



• Additional compounds have been added in the GC & GCMS groups to support recently 

identified peaks from labs, especially APT:  

o Halpern transformation & correlation ratios have been added to the Gasol-GC group. 

o An update to the Sat-GCMS group now captures the 10 commonly recognised and 

reported sesquiterpane peaks from the m/z 123 trace. 

o The missing extended hopanes H32-H35ab S&R have bee added from the m/z 205 

trace.  

• Various additions and cleanup to aliases have occurred to improve the linking for a range of 

properties reported by various labs. 

• Additional Gas and MudGas ratios were added to assist in Gas and MudGas Interpretation. The 

equations of HC (C1-C5)/Non-HC and HC (C2-C5)/Non-HC were edited to ensure a higher 

calculation rate for samples through the use of summed isomer properties for Butane and 

Pentane. 

o Added run number (Run#) to all of the Gas and a number of Extract groups. 

• The XRD group has been expanded to include Gypsum, Chlorite, and an Other (with an 

associated description for the “other” property). 

• The PVT property model, relevant to geochemistry has been edited and now includes:  

o A PVT-Ref group that is used to track the source of sample PVT information.  

o A base PVT group contains reservoir properties, single-stage flash bulk parameters, 

fluid production behaviour properties  and lab metadata.  

o A PVT-GC group is present for PVT compositional analysis reported in mol fraction, 

along with a selection of derived ratios. 

o A PVT-MSep group is provided for multiple-stage flash derived bulk properties (density, 

gas-oil ratio, formation volume factor, gas gravity) at various pressure conditions. 

o A PVT-DLib group is provided for differential liberation derived bulk properties (density, 

gas-oil ratio, formation volume factor, gas gravity) at various pressure conditions. 

o A PVT-Un group is provided for unknown derivation bulk properties (density, gas-oil 

ratio, formation volume factor, gas gravity) at various pressure conditions. 

o .Any properties have been added where appropriate for use in autographs etc.  

▪ A new set of autographs for PVT data.  

o The PVT-Visc group for flow assurance-related viscosity measurements has been 

revised. The group now has 3 reporting schemes available within it, depending on 

the temperature and pressure of the test. 

o A PVT-Flow group records values from well site flow and fluid measurements, including 

contaminants. Liquid ratio data (e.g. GOR, etc.) from the previous Bulk PVT group has 

been migrated to this group.  



o The Bulk group is retained but has been redefined to hold fluid behaviour properties, 

which are reported by geochemical labs as part of their standard geochemical 

reporting where the origin of the data is not recorded.  

• All oil density data in the previous Bulk PVT group has been migrated to this group. 

• A new Routine Core Analysis RCA group has been added to store basic petrophysics-related 

information. The property scheme considers the orientation of the unpreserved plug. 

• A comprehensive new XRF (X-ray fluorescence) group has been added for the elemental 

analysis of solids. This supports the Inorg group, where data from other elemental 

techniques, e.g., plasma spectrometry, are stored. The creation of this new group also aims 

to support carbon storage monitoring.  

• A new Pressure group has been created to enable users to store data needed to identify fluid 

types and fluid contact locations, and data associated with well drilling safety.  

o The work to add this new pressure group also saw the Mobility property (Formation 

mobility is the ratio of effective permeability relative to viscosity) added to the Phys 

group. 

• The Water group has had an overhaul, with the ionic properties relocated to their own Ions 

group and hydrocarbon and non-hydrocarbon dissolved gas concentrations added to the bulk 

chemical and physical water properties present. 

o A new Water-Iso group has also been added to provide a range of stable and unstable 

(radioactive) isotope properties used on the whole water sample and internally 

separated components. 

Fixes 
• When changing the search term in the property selector, we now always return to the top 

entry to ensure the user sees the most relevant suggestions 

• When a lot of graphs are open at the same time, or after long use of p:IGI+, sometimes you 

get no points shown on a graph and a text error message saying “E_OUTOFMEMORY: Ran 

out of memory (****)”. To address this, save the project, close p:IGI+, restart, and open the 

project. We have fixed this issue with the upgrade to support the latest .NET version 

• Occasionally, when resizing graph windows, the data view can pan unexpectedly. This is a 

rare event, but has now been fixed 

• When a user loses connection to the licence server p:IGI+ will now behave more gracefully, 

allowing the user to save their work and exit 

• Fixed a potential security vulnerability in auto-artefacts 

• Dates prior to 31st December 1899 are now exported correctly, addressing an Excel 

limitation 

• Cloning a statistics artefact will now produce an identical copy of the original artefact 

• Sample counts on the top of pages are now correct for project properties with the [*] any 

indicator 

• Editing a project property equation used to not update properly when adding a new exists{} 

clause – this has been fixed 



• Property help will now correctly jump to provide help on a property selected from a page 

even if the property help is already open 

• Addressed some issues when creating and editing overlay/underlay objects in the overlay 

editor. 

 

Known issues 
• From version 2.5 onwards p:IGI+ will no longer open version 1.x projects. Older projects 

should be converted to version 2.0 or later before updating to 2.5 or later. IGI will be able to 

provide a tool or a service to update old projects if needed. 

• The “Sitka” font family does not work when copying graphs – it displays fine, but the graphs 

will not copy correctly. We advise users to not use this font family, which has some known 

issues in Windows 

 

Installation issues 
Requires .NET framework version 6.0 

 


